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1. TeamWork Employee Guide

1. TeamWork Employee Guide

1.1 About TeamWork

ScheduleSource TeamWork is an application that helps your company manage work in your
organization. As an employee, you log in to the Employee portal and can always view your

schedule, calendar, time entries, and attendance. In addition, you can configure your language,
notifications, and other personal settings.

1.2 Common Uses

You can use the Employee portal to:

* View your schedule in a Calendar or List
* Clock On or Off

* Enter hours on your Time Card

* Request Leave

* Pick up shifts from the Swapboard

 Set up Notifications

1.3 Getting Started

First, learn about Navigation. Then, click on the various sections and pages to learn what is
available. You can refer back to this documentation to learn about each page and its capabilities.

1.3.1 Top Pages

* Home - The home page shows a quick summary of "today" along with links to common
sections.
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1.3.2 Sections

 Calendar - The calendar page shows shifts, leave, time entries and more in a month, week,
day, or list format.

1.3.2 Sections

Your sections will depend upon the organization's setup. Here's brief descriptions of what you
can find in each section.

» Schedule - Your leave, shifts, total hours, and the swapboard.

» Time - The time clock, time card, timesheets, and attendance points.

« Organization - Company (or location) wide lists of Leave, Shifts, and Coworkers.
» My Setup - Settings, preferences, and notifications.

* Bidding - Shift and Leave bidding pages.

* Events - Event/Task management pages.

* Invoices - Invoice pages and reports.
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2. Navigation

2. Navigation

2.1 Main Menu

The TeamWork main menu is located on the left of the page. If the browser is smaller (or mobile)
the menu will auto-hide and be accessible by clicking the menu button.

* Expand or collapse menu sections by clicking on the section title.

» Open a page by clicking the page iconlftitle.

(=) Calendar © Time
> Time
Clock: OFF
v Schedule 68 Card
(*) My Leave
&2 Shifts
&= Schedule
[ Totals
53 SwapBoard 2= Shifts
> Invoices §8 Swapboard
(%] Leave
> Bidding

When on a large screen (desktop) you have the option of hiding the menu and using the menu
button, or leaving it always visible on the left.

* To hide menu, click the left-arrow (located at top-right of menu area)

* To always show the menu, click the right-arrow

2.2 Quick Links

You can quickly open common pages using the quick links located at the right of the top title bar.
The links present will depend on your organization's setup. Click one of the icons to open that
page. Typical pages include: Calendar, Clock, Card, Leave, and Swapboard.

- 8/105 -

Copyright © 2023-2024 ScheduleSource, Inc.



2.3 User Menu

B 08 &5 $

2.3 User Menu

The user menu is located at the far right of the title bar. Click your name to open the menu. The
menu provides links to setup pages, help documentation. and the sign-out link. There's also an
option to toggle between Light and Dark modes, as well as enable Keep Alive (for your session).

The keep alive requires keeping the browser open and it will extend your session beyond the
normal time-out period.

Bob Abbott ®

@ Profile

29 Preferences

A Notifications
€ Toggle

< Keep-Alive: OFF

Help

Logout

2.4 Date Ranges

Many pages present date-based data. These pages will have "date navigation" capabilities to
quickly change the view based on desired time period.

The common options for date navigation are:

1. A Range (day, week, month)
2. A Date (the target)

3. Previous and Next arrows
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2.4.1 Example 1

2.4.1 Example 1

Simple date navigation

Week v  1/4/2024 al[ <> ’

2.4.2 Example 2

Calendar layout

¢ <« » | [iDec31-Jané, 2024

< January 2024 >

Day m Month | List

Tue 1/02 Wed 1/03 Thu 1/04 Fri 1/05 Sat 1/06
SU MO TU WE TH FR SA
all day
31 1 2 3 n 5 6
12:00 AM
7 8 9 10 11 12 13
14 15 16 17 18 19 20
2:00 AM 21 22 23 24 25 26 27
28 29 30 31 1 2 3
4:00 AM 4 5 6 7 8 9 10
Thursday, January 04, 2024
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3. Home

3. Home

The Home page displays summary information and links to other pages in the application.
Information and links vary based on the tools enabled by the configuration and can include Time,
Schedule, Availability, Messages, Events and Settings.

Home B O ®BE F David Hamm @
Monday, 1/22/2024 @]
© Time L) Messages
7:05 AM - Check shifts Friday 8/26
NOTIFY TEST
Clock: ON
BB Card
) Events
&% Schedule
23 Shifts @ Settings

7am-3pm, Pharmacist @ Denver, Break: 10:45am-11:15am
Name: Hamm, David

£ Swapboard Email: scott@schedulesource.com

) Leave
) Availability
Denver: All Day
Maui: 1:00 PM - 12:00 AM
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4. Calendar

4. Calendar

The Calendar displays your schedule for each of the stations and locations you are assigned to.
Set display options (what will be visible), view your schedule and your availability.

4.1 Calendar Settings

Choose the options to display on your calendar by clicking the settings icon above calendar. The
options to display include: Schedule, Time, SwapBoard, My Leave, Availability and Events.

Calendar » Display

Schedule
Time
SwapBoard
My Leave
Availability
Events

Choose the time-frame to display in the upper right corner of the page: Day, Week Month or List.

& ¢

o <« » [GJan21-Jan27, 2024 > Daym Month  List

Sun 1/21 Mon 1/22 Tue 1/23 Wed 1/24 Thu 1/25 Fri 1/26 Sat 1/27

all day ]x 1Swap 1 Swap ‘

6:00 AM

7am-3pm,

[0 7am-3pm, Pharmacist
@ Denver, Break:

®©0pen
Clocking -

4.2 Calendar Pop-Up

Click an item on the calendar to see options for editing, approving etc.
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4.2 Calendar Pop-Up

l 7am-3pm |

Pharmacist @ Denver
Break: 10:45am-11:15am

OK? -‘ Open —

Close
®© Open (0 7am-3pm, Pharmacist
Clocking - @ Denver, Break:

On:7:05am 10:45am-11:15am
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5. Schedule

5. Schedule

5.1 My Leave

To view the summary of your Leave Requests, select the year (top-left corner of the page). Your
Leave Requests appear in order and include the status (Granted, Requested, Denied). You can

amend or delete a Leave Request in Requested Status.

My Leave
2024 B[ <|[>] [Ad]

Drag a column header and drop it here to group by that column

Status From To Month Days Hours
REQUESTED Jan 14 (Sun) Jan 20 (Sat) January 7 40.00
REQUESTED Apr 07 (Sun) Apr 13 (Sat) April 7 56.00

My Leave Balances

Name Check Start End Quota (Hours) Granted Taken Remaining Quota (Days)

PTO No 1/2/2024 12/31/2024 120.00 0.00 0.00

5.1.1 Requesting Leave

1:00 AM - 1:00 AM

1:00 AM - 1:00 AM

B O B 8 David Hamm @

o

Type Comment Actions
PTO ‘ Open ‘

PTO | Open |

Granted Taken Remaining

0 0

1. Click the Add button at top of page
. Select a Leave Type

. Select dates

. (Optional) Adjust hours per day

2
3
4. (Optional) Select times if not "all day"
5
6. (Optional) enter notes

7

. Click Save
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Leave

Dates:

Times:

Hours:
Comment:

Checks:
Ok

Leave Type:

PTO
1/22/2024

Jan-22
8.00

8.00

2 - 1/22/2024
@ -

&
®

4

‘ Close ‘

5.1.2 Editing Requests

5.1.2 Editing Requests

If leave requests are not yet granted, they can be edited or deleted. Click the Open button in the

row you wish to edit.

1. Make changes to values, click Save

2. Or, click Delete to remove the request
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Leave

Dates:

Times:

Hours:
Comment:

Checks:
Ok
Status:

Leave Type:

PTO

4/7/2024 [ - 4/13/2024 [3
1:00 AM ® - 1:00 AM ®
Apr-7 Apr-8 Apr-9 Apr-10 Apr-11
8.00 8.00 8.00 8.00 8.00
Apr-12 Apr-13

0.00 0.00

40.00

REQUESTED

‘ Close ‘

5.1.3 Leave Statuses

5.1.3 Leave Statuses

There are five statuses for leave requests:

1. Requested - Waiting for approval.

2. Granted - Has been approved.

3. Denied - Not approved.

4. Cancel Requested - A granted leave with a cancellation request.

5. Cancelled - Approved cancellation of granted leave.

In some configurations, it's possible to have certain leave types auto-approve upon request. In

addition, there may be additional constraints placed on leave availability that could impact auto-

approve. Otherwise, most requests are reviewed and approved or denied by managers.
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5.2 My Shifts

5.2 My Shifts

To view your Shift information, select the duration of time you want to view (day, week, month) in
the upper left-hand corner of the page. Select the date you want to display information around.
Shift information will display in chronological order and will include the Location, Date, Start,
End, Breaks (if required), Station (Position), Hours and other relevant information.

You can sort, filter, and group the shift data using the column headers.

Rob Abobo @

O Home . Month ~  1/9/2024

&) Calendar

Time

Location Y Date Y Start Y tnd Y Break Y Station Y Gowp Y Client Y Notes Y Hours Y Actions
Schedule

Guest Services Thu, VIV2024 1030 AM 7:00 PM Sk School 800
£ My Leave

Al Locations 500 AM T20PM Vacation - GRANTED 800
B Tots

Guest Services 10:30 AM 700 PM Food Service 8.00
B Swaplomd

2024 10:30 AM 7.00 PM Ski School 800
Bidding
Wed, V17/2024  10:30 AM 700 PM Food Service 800 S

Organization

The 10:30 AM 700 PM Sk S Ol 800

My Setup
Guest Services Set. V202024 10:30 AM 700 PM Ski School 800
Shifes: 8 64.00

Depending on your organization’s rules, you may be able to Swap or Split an upcoming shift.
Select your preferred Action in the last column of a shift.

Guest Services Tha 1172024 1030 AM 7:00 PM Ski School 800
2 My Loave

All Locations Fri 11272024 500 AM 720 PM Vacation - GRANTED 800
A Totaks

Guest Services Mon, 1/15/2024 1030 AM 7.00 PM Food Service 800
T Swaplo

Guest Services Tue, 116/2024 1030 AM 700 PM
Bidding

Guest Services Wed, 1/17/2024 %030 AM 7:00 PM Food Service 800
Organization

Guest Services Tha, 118/2024 030 AM 700 PM Ski School 800
My Setup

sest Service Sat. 1 B 30 AM 700 PM hool 800
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5.2.1 Swapping Shifts

5.2.1 Swapping Shifts

Posting a shift to the Swapboard makes it available for others to claim. To exchange shifts with
another employee, the posting must be designated a trade. When swapping or trading out shifts,
they remain on you schedule until a swap is completed.

1. Click Swap in the Actions column

2. Select Swap, Trade, or Either for the type of swap

3. (Optional) Select a specific employee to offer shift to

4. Click Save

Swap

Guest Services, Ski School, Sat 1/20/2024
10:30 AM - 7:00 PM (12:30pm-1pm)

O Trade O Either

Swap With:
Anyone v

You remain responsible for the shift until it is claimed.

- [

Employees v

5.2.2 Splitting Shifts

If you wish to give up a portion of a shift and retain the rest, the shift must be split. Splitting a
shift creates one or two new shifts (depending on the split times). Any of the shifts can then be
posted to swap independently of the others.

1. Click Split in the Actions column

2. Select a time to split (its the end and start time of the two shifts that will result)

3. Click Save
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Split X

Guest Services, Ski School, Sat 1/20/2024
10:30 AM - 7:00 PM (12:30pm-1pm)

Shift #1: 10:30 AM - 2:45 PM 3.75
End/Start: 2:45 PM v
Shift #2: 2:45 PM - 7:00 PM 425

—me

ol

5.2.3 Approving Shifts

5.2.3 Approving Shifts

If shift approvals are enabled, you can click the OK? button to approve the shift. This marks the
shift with an OK tag for managers to see. Once a shift is approved it cannot be un-approved.

Actions

-/- Split H Open — ‘

OK? ‘ Swap ‘ -/- Split H Open — ‘

OK? | Swap || -/- Split ‘ Open — ‘

5.2.4 Open a Shift

Click the Open button in the Actions column to load a new page with shift information. If the

shift's location or client has address information, it will be listed.

- 19/105 -
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5.2.4 Open a Shift

Depending on configuration, several additional actions might be available from the Open Shift
page. These include:

e Cancel - inactivate the shift

* Remove - unassign yourself from the shift

‘ Back‘
Shift Actions
OK? Remove
Date: Thursday, 1/25/2024
Times: 7:00 AM - 3:00 PM 8 Hours
Break: -
Location: Denver
Position: LPN
Client:
-20/105 - Copyright © 2023-2024 ScheduleSource, Inc.



5.3 Totals

The totals page summarizes hours per week for the selected year.
Totals B O ®BH Dave Fischer @
2024 gl <] >| o
Drag a column header and drop it here to group by that column

Location Y Week Y shifts Y Hours Y
Denver 12/31/2023 3 17.00
Denver 1/7/2024 4 21.00
Denver 1/14/2024 2 12.00
Denver 1/21/2024 3 18.00
Denver 1/28/2024 3 18.00
15 86.00

5.3.1 Filter Example

You can filter any of the columns of table to narrow down the data returned. The example below
shows a filter to limit the list to weeks with 40 or more hours. Click Filter on the form to set the
filter. Remember to Clear the filter to see all data again.

Hours Y
Show items with value that:

Is greater thanorequalto v

<)

40
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5.4 Swapboard

5.4 Swapboard

The Swapboard's primary purpose is to list available shifts. These shifts can be claimed by
employees, depending on additional checks and rules.

The Swapboard has three sections:

1. Counts - listing available shifts per day,
2. My Shifts - already assigned shifts, and

3. Available Shifts - open or posted shifts for claiming.

Clicking on any of the section headers will expand or collapse that section.

5.4.1 Viewing Counts

The Counts section has two views. One view shows three months of data in calendar form. The
other view shows a single horizontal row with the same information.

The counts are color-coded in the views:

* Blue numbers are My Shifts
» Orange numbers and Available Shifts
» Green text represents Granted Leave

* Red alerts indicate swaps directed to "me"

-22/105 -
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5.4.2 My Shifts

Calendar View
Welcome to V6! B O B M Dave Fischer @
Day v 1/23/2024 B T‘ ‘? Tuesday, January 23, 2024 1)
COUNTS v = Key: My Shifts [Available| Leave Partial IDirected To Me
< January 2024 > < February 2024 > < March 2024 >
Ny MO TU WE TH FR SA SuU MO TV WE TH FR SA SuU MO TU WE TH FR SA

1 1 T M 12 13 14 15 16 17 0 1 12 13 14 15 16
26 29 30 31 - = = =-=—J - —f = = = = ==J =
- 1 1 18 19 20 21 22 23 24 1718 19 20 21 2 23
25 26 27 28 29 24 25 26 27 28 29 30

31

Single Row View

Welcome to V6! Dave Fischer @
Day v 1/23/2024 ] ‘ < H > Tuesday, January 23, 2024 @]
COUNTS v Key: My Shifts (Available| Leave Partial IDirected To Me
Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri Sat Sun Mon Tue Wed
Jan-24 Jan-25 Jan-26 Jan-27 Jan-28 Jan-29 Jan-30 Jan-31 Feb-01 Feb-02 Feb-03 Feb-04 Feb-05 Feb-06 Feb-07 Feb-08 Feb-09 Feb-10 Feb-11 Feb-12 Feb-13 Feb-14 F|
‘ 1 ‘ 1 ‘ 1 ‘ ‘ ‘ ‘ ‘ 1 ‘ 1 ‘ 1 ‘ ‘ l 77 ‘ 132 ‘ 134 ‘ 135 ‘ 136/ ‘ 137 ‘ |68 l ‘ ‘ ‘ ‘

5.4.2 My Shifts

This list offers the same information as the My Shifts page. It's provided for reference. However,
you can perform the same actions on shifts including Swap and Split.

@ MY SHIFTS
Location Date Position Group Client Notes Start End Break Hours Actions
Denver 1/23/2024 (Tue) Pool 9:00 AM 3:30 PM 12:00 PM - 12:30 PM 6.00 ‘ -/- Split ‘ Open —

Shifts: 1 6.00

5.4.3 Available Shifts

Available shifts can be Claimed and added to your schedule. Click the Check button to start the
process. Organizational checks and rules must pass before the shift can be claimed. If allowed,
shifts can be split/checked as well to see if a portion of a shift is available.
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\‘a AVAILABLE SHIFTS|

Drag a column header and drop it here to group by that column

5.4.4 Claiming a Shift

Location Y Date Y Position Y Group Y Client Y Start Y End Y Break Y Hours Y Notes Y Assigned Y Actions

Denver 2/4/2024 (Sun) RN 7:00 AM 11:30 AM 4.50

Denver 2/4/2024 (Sun) RN 7:00 AM 11:30 AM 4.50

Denver 2/4/2024 (Sun) RN 7:00 AM 11:30 AM 450

Denver 2/4/2024 (Sun) RN 7:00 AM 11:30 AM 4.50

Denver 2/4/2024 (Sun) Tech 8:00 AM 11:30 AM 3.50
5.4.4 Claiming a Shift

1. Click the Check button to open the swap checker

2. If enabled, click Claim to put the shift on your schedule

Claim

2:00 PM - 6:00 PM
Check

Is ((GLOBAL]) OK?

Times open in schedule?
Day-to-Day downtime OK?

Shift gaps OK?

Consecutive Hours OK?

Within max hours/day?

Within max hours/week?

Within max days/week?

Within max shifts/day?

Empty shift lead time buffer > 1?

Denver, Pool, Sat 2/10/2024

(@)

OK

No

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

In the example above, the Global Availability shows a conflict but the shift can still be claimed.
Other checks might prevent the shift from being claimable.
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5.4.5 Split/Claim a Shift

5.4.5 Split/Claim a Shift

For empty (unassigned) shifts on the Swapboard, you may choose to claim only a portion of the
shift. To do this click the Split button on the initial check pop-up. This launches the Split/Claim

pop up where you can choose the split time and the segment to claim.

1. Click Split to open new pop-up
2. Choose a Split Time in the first selector

3. Click Check for the portion you wish to claim

4. Click Claim
Split / Claim X
Denver, RN, Sun 2/4/2024
6:00 AM - 10:30 AM
Split: 8:15 AM Y 10:30AM ©
Shift #1: 6:00 AM - 8:15 AM 2.25 | Check
Shift #2: 8:15 AM - 10:30 AM 2.25 | Check \
Close

After clicking Check the results are listed and either Claim button will claim the shift.
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Split / Claim X

Denver, RN, Sun 2/4/2024
6:00 AM - 10:30 AM

Split: 8:15 AM vy 10:30AM v
Shift #1:  6:00 AM - 8:15 AM 2.25 ’ Check ‘
Shift #2:  8:15 AM - 10:30 AM 2.25 ‘ Check ‘

Denver, RN, Sun 2/4/2024

6:00 AM - 8:15 AM e ————i (il
Check Status
Is ((ROTATION]) OK? Yes
Times open in schedule? Yes
Within max hours/day? Yes
Within max hours/week? Yes
24 Hours Yes
Within max days/week? Yes
Within max shifts/day? Yes
Empty shift lead time buffer > 1? Yes

‘ Close ’

=
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6. Time

6. Time

6.1 Time Clock

The time clock enables real-time tracking of time and attendance. Many organizational rules and
configuration settings impact the time clock. Depending on these settings employees may need
to be scheduled, at a particular location, or in certain groups to be able to clock.

To Clock On an employee selects a location, project/task, and optionally an activity or client.
This creates an "open" time entry with the start time captured when submitted. From that point,
an employee can Transfer or Clock Off. It it not necessary to remain signed in to TeamWork
once clocked on. In some configurations, an auto-clock off job may end the time entry after a
certain number of hours. In this case the entry is also marked as an *Error.

The time clock will ask for your geo-location, so that it can be logged. In some cases, the system
may prevent clocking on or off if not within a pre-defined region for the location (or client).

Thursday, March 07, 2024 4:40:24 PM (@]

Status Today

@O lock Off 4 AM 12PM 8PM
n Clzde© Entries:

a ([XT)) 4:40 PM - Denver / REG / Onsite

Transfer Geolocation

Location: Lat: 39.959429 Long: -105.508894 | View Map v
Denver v

Project / Task:

REG / Onsite v
Activity:

--- Please Select --- A

6.1.1 Opening the Clock

Navigate in the main menu to Time > Clock, or click Clock (or clock icon) in the top header.
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Vv Time

88 Card

6.1.2 Clocking On

6.1.2 Clocking On

To clock on:

1. Select a Location

2. (Optional) Select an Client
3. Select a Project/Task

4. (Optional) Select an Activity
5. Click Clock On

Clock On

Location:
Denver
Project / Task:
REG / Onsite v
Activity:
--- Please Select --- v

Clock On

6.1.3 Clocking Off

If you are already clocked on, a Clock Off button is available in the "Status" section. Clicking

Clock Off will end your time entry and reset the time clock.
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6.1.4 Transferring

Status

O On Clock Off
0.05_

6.1.4 Transferring

If you are already clocked on, you can Transfer to a new location, project/task, etc. This allows

tracking detailed time within the day or shift.
To transfer:

1. Select a Location

2. (Optional) Select an Client
3. Select a Project/Task

4. (Optional) Select an Activity
5. Click Transfer

Transfer

Location:
Denver
Project / Task:
REG / Office v
Activity:
--- Please Select --- v
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5.1.5 Viewing Today's Clockings
6.1.5V g Today's Clocking

6.1.5 Viewing Today's Clockings

The "Today" section on the clock page lists any scheduled shifts along with time entries. You can
click the times of a time entry to open an editor with more details. (Editing clockings is optional
and depends on setup.)

Today

4 AM 12 PM 8 PM
Entries: |

4:40 PM - 4:44 PM Denver / REG / Onsite
4:44 PM - Denver / REG / Office

6.1.6 Viewing Geo-Location

The "GeoLocation" section on the clock page shows your coordinates as captured by the
browser. You can click the View Map button to load a map with a marker for your location.
(Viewing geo-location is optional and depends on setup.)
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6.1.6 Viewing Geo-Location

Geolocation

Lat: 39.959429 Long: -105.508894 | View Map v
ark-n-Ride ' o

e

-31/105 -

Copyright © 2023-2024 ScheduleSource, Inc.



6.2 Time Card

6.2 Time Card

The time card enables management of time entries. Employees can enter time after-the-fact, or

for the future (e.g. PTO). Many organizational rules and configuration settings impact time

entries, but generally they can be added and edited for several weeks on the time card.

The top section of the card shows any scheduled shifts. The bottom section of the card shows

time entries.

3/7/2024 B <|[>]

Sun Mon Tue

Mar 3 Mar 4 Mar 5
Denver, Pharmacist
Denver, Pool
Schedule 0.00 0.00 0.00
Denver, REG/Office
Denver, REG/Onsite

add)  (ad| [l
Time 0.00 0.00 0.00

6.2.1 Opening the Card

Wed
Mar 6

7am-3pm

7.50

7am-3pm 8.00
Add

8.00

Thu
Mar 7

0.00

4:44pm-On m 0.00

4:40pm-4:44pm 0.07
Add |

0.07

@]
Fri Sat Totals
Mar 8 Mar 9
7.50
8am-1pm 5.00
5.00 0.00 12.50
0.00
8.07
| a3
0.00 0.00 8.07

Navigate in the main menu to Time > Card, or click Card (or card icon) in the top header.

Vv Time

O Clock
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6.2.2 Navigating Weeks

6.2.2 Navigating Weeks

The time card displays a week at a time.

 Use the arrow buttons to navigate to the previous or next week.

* Use the date-picker to go directly to a week (that contains the date).

3/7/2024 Bl <>

6.2.3 Adding Time

There are two ways to add time on the time card: 1) From a scheduled shift, 2) By day as
needed. The benefit of adding from scheduled shifts is the times for the entry will be pre-
populated with the times from the shift.

Add From Schedule

To add an entry from a scheduled shift, look in the scheduled shifts section of the card for shift
times. A blue button indicates no time entry, whereas grey indicates there is a time entry for the
shift.

8am-1pm

1. Click the times button for the shift

2. Correct times if needed

3. (Optional) Enter break hours (decimal) to subtract from time span
4. Select Location, Project/Task, etc.

5. (Optional) Enter notes and select Alert Manager if there's a need to communicate something
about this entry

6. Click Add
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6.2.3 Adding Time

Entry » Add X
Date: 3/8/2024 &
Schedule: Start End Hours
8:00 AM 1:00 PM 5
Times: 8:00 AM ® - 1:00 PM C)

Break Hours:

Calculated Hours: 5.00
*Project / Task: REG / Onsite
Activity: --- Please Select ---
Notes:
VY
Alert Manager: No M
| S
Add By Day

To add an entry to the time card on a specific day:

1. Click Add in the bottom row of the card

2. Enter Start and End Times

3. (Optional) Enter break hours (decimal) to subtract from time span
4. Select Location, Project/Task, etc.

5. (Optional) Enter notes and select Alert Manager if there's a need to communicate something
about this entry

6. Click Add

Add |
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6.2.4 Editing Time

6.2.4 Editing Time

In general, time entries on the card can be edited. In some cases, organization setup or locked
pay periods can prevent editing.

To edit an existing entry on the card, click the hours link.

4:44pm-On m M

4:40pm-4:44pm 0.07

This opens the time entry editor. If editing is allowed, the times, break hours, etc. can be
changed. If editing is not allowed, the Employee Notes and Alert Manager fields can still be
changed and saved.

Entry » Edit X
Status: card: m

*Date: 3/6/2024

*Times: 7:00 AM 9 - 3:00PM C

*Break Hours: 0.00 .

Calculated Hours: 8.00

*Location: Denver M

*Project / Task: REG / Onsite M

Employee Notes:

N\

Alert Manager: No ¥

Manager Notes:

Save Close
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6.3 Timesheet

6.3 Timesheet

The timesheet summarizes the time and approvals for an employee's pay period. The
"Summary" section lists approvals and totals. The "Details" section shows the time entries
grouped by date. An optional third section, "Differentials", will show the differential hours
calculations breakdown.

Several actions can be taken directly from the timesheet: Approval, Add, and Edit entries.

Pay Period: 3/2/2024 3/15/2024 <> o
Summary v/

Location Local Manager Enterprise Organization Open Error Void Valid Regular Total
Denver Not Locked Not Approved Not Locked Not Approved 0 0 0 3 8.83 8.83

Details Add

Type Location Project Task Activity On Off Regular Total Status Actions
v Date: 3/6/2024 (Wed); Entries: 1; Total: 8.00

card Denver REG Onsite 7:00 AM 3:00 PM 8.00 8.00 ‘ Open
¥ Date: 3/7/2024 (Thu); Entries: 2; Total: 0.83

clock  Denver REG Onsite 4:40 PM 4:44 PM 0.07 0.07 ‘ Open
clock  Denver REG Office 4:44 PM 5:30 PM 0.77 0.77 ‘ Open
5 8.83 8.83

6.3.1 Approving Time

If timesheet approvals are allowed, there will be a button for submitting approval. If you approve
the timesheet, it becomes locked from editing. Do not submit an approval if any additions or
edits might be needed.

Summary Vv
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6.3.2 Unapproving Time

To approve the timesheet:

1. Click the Approve button
2. Review the dates to ensure the correct pay period

3. Click Approve

This action approves all time entries for the timesheet (pay period).

Approve X

Dates:
3/2/2024 - 3/15/2024

Approve & Lock all time entries for this Timesheet

By clicking APPROVE button you are stating that the time entries
on this Timesheet are correct.

You will not be able to do any further changes or additions to this

time range.

6.3.2 Unapproving Time

If you do need to make edits, and the organization has not yet locked or approved the pay

period, you can undo your approval by clicking Unapprove.

Summary Vv

Employee Approved | Unapprove

To un-approve the timesheet:

1. Click the Unapprove button
2. Review the dates to ensure the correct pay period

3. Click Unapprove
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6.3.3 Adding Time

Unapprove X

Dates:
3/2/2024 - 3/15/2024

Undo employee approval of timesheet?

= -

6.3.3 Adding Time

To add an entry to the time sheet, click the Add button in the details section.

Details v/ Add

1. Enter Start and End Times
2. (Optional) Enter break hours (decimal) to subtract from time span
3. Select Location, Project/Task, etc.

4. (Optional) Enter notes and select Alert Manager if there's a need to communicate something

about this entry
5. Click Add
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6.3.4 Editing Time

Entry » Add X
Date: 3/8/2024 &
Schedule: Start End Hours
8:00 AM 1:00 PM 5
Times: 8:00 AM ® - 1:00 PM C)

Break Hours:

Calculated Hours: 5.00
*Project / Task: REG / Onsite v
Activity: --- Please Select --- v
Notes:
V
Alert Manager: No M

6.3.4 Editing Time

To edit an existing entry in the sheet, click the Open button in the "Actions" column.

Actions

Open

This opens the time entry editor. If editing is allowed, the times, break hours, etc. can be
changed. If editing is not allowed, the Employee Notes and Alert Manager fields can still be

changed and saved.
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6.3.4 Editing Time

Entry » Edit X
Status: card: m

*Date: 3/6/2024 i

*Times: 7:00 AM © - 3:00PM ®©

*Break Hours: 0.00 :

Calculated Hours: 8.00

*Location: Denver M

*Project / Task: REG / Onsite \d

Employee Notes:

Alert Manager: No ¥

Manager Notes:

Save Close
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6.4 Attendance

6.4 Attendance

The attendance page lists issues with time entries over the past year or defined date range.
Issues are created based upon organizational rules and constraints. Each issue may have a
point value assigned. Points might represent the impact of the issue to the organization. If your
organization uses Attendance, you should regularly review this page for your status.

Attendance =NON::Nalk= David Hamm @
1 . Year(s) From Date Vv 1/12/2024 [ i) ‘ < ‘ > O
Drag a column header and drop it here to group by that column
Location Y Date Y Message Y Status Y Points Y Minutes Y Notes Y
Denver 12/19/2023 Not Scheduled Open 1 0
Denver 12/19/2023 Not Scheduled Open 1 0
Denver 11/27/2023 Not Scheduled Open 1 0
Denver 11/20/2023 Clock Out Early Open 2 295
Denver 11/20/2023 Not Scheduled Open 1 0
Denver 11/18/2023 Not Scheduled Open 1 0
Denver 11/7/2023 Not Scheduled Open 1 0
Denver 11/7/2023 Not Scheduled Open 1 0
Denver 10/17/2023 Not Scheduled Open 1 0
Denver 10/11/2023 Clock Out Early Open 2 186

Use the Date Navigator at the top of the page to load data for different time periods.

6.4.1 Issues

Each issue is for a location and date. Issues are reviewed by manager and assigned a status of
"Confirmed" or "Void". A status of "Open" indicates an issue not yet reviewed.

* Message - A short description of the issue.

« Status - The manager review status. "Open", "Confirmed", or "Void".

* Points - A system or manager assigned point value for the issue.

* Minutes - The duration of the issue. For example, late clock in might have "12" minutes if you
clocked in 12 minute late.

* Notes - Manager entered notes about the issue.

-41/105 - Copyright © 2023-2024 ScheduleSource, Inc.



/. Organization

7. Organization

7.1 Organization Shifts

To view all shifts, select the duration of time you want to display shifts for (Day, Week, Month)

and select the Location that you want to view shifts for. Shift information returned includes the

day and date, station, employee, start and end time and if the shift is available on the

swapboard. Your own shifts will be highlighted, as shown in the image below.

Day v  2/14/2024 | <> | Denver
t Date @
Date Y Position Y Employee

v Date: Wed, 2/14/2024

Wed, 2/14/2024 LPN Abbott, Bob
Wed, 2/14/2024 Pharmacist Hamm, David
Wed, 2/14/2024 Pool Bloom, Allison
Wed, 2/14/2024 Pool Fischer, Dave
Wed, 2/14/2024 Tech Barnaby, Red
Wed, 2/14/2024 RN Wetz, Jim
Wed, 2/14/2024 LPN Semento-Smith, Johnny
Wed, 2/14/2024 Pool Hanson, Hank
Wed, 2/14/2024 Pharmacist Svendson, Ulla
Wed, 2/14/2024 Tech Smith, Bob
Shifts: 10

v

6:00 AM
7:00 AM
8:00 AM
8:00 AM
9:30 AM
11:00 AM
12:00 PM
1:00 PM
2:00 PM
3:00 PM

Client Y Group Y Notes Y Start Y End Y Break

2:00 PM

3:00 PM 10:45 AM - 11:15 AM
12:00 PM

12:00 PM

3:00 PM

7:00 PM 2:45 PM - 3:15 PM
4:00 PM

6:00 PM

8:00 PM 5:15 PM - 5:45 PM
8:00 PM

Y Hours

o

Y SwapBoard

8.00
7.50
4.00
4.00
5.50
7.50
4.00
5.00
5.50
5.00
56.00

The Organization pages show information for other employees, as allowed by the organization setup.

-42/105 -

Copyright © 2023-2024 ScheduleSource, Inc.



7.2 Organization Leave

7.2 Organization Leave

To view all leave, select the location that you want to view leave for. You can navigate forward or
back by month using the navigation arrows. Granted leave is show by a green bar in the
calendar, requested leave is shown by a yellow bar and denied requests are shown in red. The
list of granted leave is shown below the calendar.

Leave

Denver Y o
Today <« » i February, 2024 (@]
Sunday Monday Tuesday Wednesday Thursday Friday Saturday
28 29 30 31 01 02 03
1 - DENIED
04 05 06 07 08 09 10
11 12 13 14 15 16 17
18 19 20 21 22 23 24
1- GRANTED 1 - GRANTED 1 - GRANTED 1 - GRANTED 1- GRANTED 1 - GRANTED
25 26 27 28 29 01 02
1 - GRANTED 1- GRANTED 1- GRANTED 1 - GRANTED
03 04 05 06 07 08 09

Key: Granted Requested @ Cancelled

Granted Leave Requests

Drag a column header and drop it here to group by that column

From To Leave Type Days Employee
Feb 19 (Mon) Feb 28 (Wed) PTO 10 Hamm, David

The Organization pages show information for other employees, as allowed by the organization setup.
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7.3 Organization Coworkers

7.3 Organization Coworkers

To view all of your coworkers and their contact information, select one of your locations. The
page will list employees for that location and any contact information.

Coworkers

Denver ) o
Drag a column header and drop it here to group by that column
Name Y Phone Y Phone Y Phone Y Mobile Y Crew Y Email Y
_TEST, DO_NOT USE
Abbott, Bob Vol
Barnaby, Red FT
Bloom, Allison FT
Dokken, Kip i o kili FT k -
Fischer, Dave PT
Galloway, Alberto PT
Green, Paul Y D FT

The Organization pages show information for other employees, as allowed by the organization setup.
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7.4 Organization Messages

7.4 Organization Messages

TeamWork supports creating, storing, and broadcasting messages via Email or Text. Messages
can be flagged as "Alerts". Each message can be shared with a unique group of employees or

managers. Messages have an effective date ranges so they may only be visible for some date
span.

To view messages, open the menu Organization > Messages.

Use the tabs to filter the messages to Alerts only, Recent only, or All. Use All to see your own
message that have expired.

=

Alerts Recent All [L1am going to be late | Edit
need someone to take a shift Checking freq. of send
Rob Abobo ()

[*]1am going to be late

Abobo, Rob @1/13/2022 10:56 AM
Abobo, Rob

Replies ()

7.4.1 Adding Messages

To add a message, click the Add button above the message list.
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A W N -

(o

o

7.4.2 Sharing

Then,

. Enter Effective Dates (the message only appears in this range)

. Enter Title

. (Optional, recommended) Enter Notes

. Select options

. Is Alert marks this message as urgent

. Allow Replies lets other submit a comment/reply to the message

. Enabled toggles the message on/off for all shares

. Click Save
<
Message X
Settings Shares Broadcast
Effective Dates: 2/8/2024 [ - 2/14/2024 [ «
*Title: Valentine Cookies for everyone h
Notes: Let's have a cookie buffet on Valentine's. Bake and bring your favorite to
share. Thanks everyone!
7%
“ Is Alert Allow Replies
Enabled
Delete Save Close
7.4.2 Sharing

Messages are only visible to yourself unless you share them with others. The Shares tab let's
you search for and select employees or managers.
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7.4.3 Broadcasting

To add shares to a message:

1. Click the "Shares" tab in the message editor

2. Use the By: and For: selectors to define an audience. Click Search.
3. Select items in the left list.

4. Click the single arrow to add items to the right list (the shares).

5. Use the double-arrow to add all items to the right list.

6. Click Save

Message ~ X

Settings Shares Broadcast

Byl Location v For:|Emplo... ¥ | Search ‘ /
Location - Employees: Guest Services 4 ocation - Employees: Ski Patrol
Location - Employees: Ski School .

»

«

e (D

7.4.3 Broadcasting

Messages can be sent to shares via Email or Text. Each recipient must have their Email or
mobile number in the system to receive the message.

To broadcast a message:

1. Click the "Broadcast" tab in the message editor
2. Check the boxes for Email and/or Text under "Channels"

3. Click Broadcast
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7.4.3 Broadcasting

Message

Settings Shares Broadcast

Channels:

Email O Text - pmmmm—

Broadcasting a message will send an email to every user that
1. Has share access to this message
2. Has a valid email address or mobile number

Broadcast

Delete

\
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7.5 Organization Events

7.5 Organization Events

TeamWork supports creating, storing, and broadcasting events via Email or Text. Each event

can be shared with a unique group of employees or managers. Events have date ranges and

appear on the Event calendar.

To view events, open the menu Organization > Events.

Navigate to different date ranges using the arrows or the date-picker on the left. Change the

view (date range) to Day, Week, or Month by clicking the ranges on the right.

Add

Today <« » [3 February, 2024

Sunday

28

04

25

03

Monday

29

05

26

04

Tuesday

06

20

27

05

Wednesday

Cookies for all!

21

28

06

Thursday

01

08

22

07

Day Week m List

Friday Saturday
02 03
09 10
Inventory of gear
OT eligible for those willing to

help that already have 40 hours
this week.

16 17

23 24
All Staff Mtg. - Mandatory!!

01 02

08 09

7.5.1 Adding Events

To add an event, click the Add button above the event calendar.
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7.5.2 Sharing

Then,

. Enter Dates (the event is on these dates)

. (Optional) Select Show On to only show the event on a certain week day
. (Optional) Enter times

. Enter Title

. (Optional, recommended) Enter Notes

. (Optional) check Allow Replies to let others submit a comment/reply

. Click Save

f

Event X

Settings Shares Broadcast

Dates: ﬁ 2/8/2024 [ - End B Show On: v
Times: ﬁ From ® - To C)

Title: #

Notes:

z
U Allow Replies

Delete ‘ Save Close

7.5.2 Sharing

Events are only visible to yourself unless you share them with others. The Shares tab let's you
search for and select employees or managers.
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To add shares to an event:

1. Click the "Shares" tab in the event editor

2. Use the By: and For: selectors to define an audience. Click Search.

3. Select items in the left list.

4. Click the single arrow to add items to the right list (the shares).

5. Use the double-arrow to add all items to the right list.

6. Click Save

(Showing Messages editor - they work the same)

Settings

Message ~

Shares

Broadcast

Byl Location

v

For:

-
Emplo... ¥

Location - Employees: Guest Services

Location - Employees: Ski School .

Search ‘ /
4 ocation - Employees: Ski Patrol

»

«

e (D

4

7.5.3 Broadcasting

7.5.3 Broadcasting

Events can be sent to shares via Email or Text. Each recipient must have their Email or mobile

number in the system to receive the event.

To broadcast an event:

1. Click the "Broadcast" tab in the event editor

2. Check the boxes for Email and/or Text under "Channels"

3. Click Broadcast
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7.5.3 Broadcasting

(Showing Messages editor - they work the same)

r

Message X

Settings Shares Broadcast

Channels:

Email O Text i mmmmmm—

Broadcasting a message will send an email to every user that:
1. Has share access to this message
2. Has a valid email address or mobile number

Broadcast

o D
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7.6 Organization Feedback

7.6 Organization Feedback

The Feedback page allows employees to submit responses to survey-like forms. These forms
are designed by the organization and may be used for a variety of purposes. Each form can be
submitted more than once enabling a tracking log of information. Your information is saved with
the data such that responses can be tracked by employee.

Open the Feedback page from the menu Organization > Feedback

7.6.1 Viewing Responses

To view the data for a given survey form, select the name from the list:

Feedback

Production Summary h ‘ Add ‘

Production Summary

This loads all the responses for that survey.

Feedback

Production Summary v ‘ Add ‘ O

Time Y Throughput A Y Throughput B Y Task Types Y Note h g

3/8/2024 10:57 AM 22 55 Other QA Normal day

7.6.2 Adding a Response

To add a new response, click the Add button at the top of the page.
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7.6.2 Adding a Response

Then,

1. Enter or select values in the form.
2. (Optional) Add comments for this response.

3. Click Save

A
ﬂease Ensure Accuracy

Once the response is saved it is not editable.

Feedback X
* Throughput A : 22.00
* Throughput B : 55.00
* Task Types : QA © Other © | X
Comments:
W
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8. My Setup

8. My Setup

8.1 Profile

The Profile page allows you to update your your password, view and update your contact
information (subject to your organizations settings) and review your deployments that inform
your schedule. You can see what Locations (schedule groups) you can be scheduled to, the time
zone of that location, and what stations (positions) you can work.

Name Username: bob  Password:

Bob Abbott Nick Name

Contact Information

Email: Address:

Phone: Address 2:

Mobile: City:

Phone 2: State:

Phone 3: Postal
Code:

Fax: Country:

Save

8.1.1 Updating Password

To change your password, click the Change button at the top-right of the "Profile" page. Then,

1. Enter your Current password
2. Enter the New password (repeat in Repeat New box)

3. Click Submit
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8.1.2 Updating Contact Information

Password X
Current: Required
New: Required
Repeat New: Required

New Password Requirements
* Not a repeat of any previous password
e These characters are not allowed: < > ' "
¢ Case-Sensitive

8.1.2 Updating Contact Information

If you organization allows editing, you can enter add or change your contact information. Simply
enter new values in the Contact Information section and click Save.

8.1.3 Viewing and Editing Attributes

Attributes are additional values associated with an employee record. In some cases the
organization may enable viewing and editing of attribute values.

To edit attributes, enter new values and click Save.

Attributes

Answer Time:
Availability:

Graduation Status: mm /dd/yyyy

Save
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8.1.4 Deployments

8.1.4 Deployments

TeamWork supports cross-location scheduling as well as different deployment of skills per

location. The Deployments section lists your locations and other information related to your

assignment to that location.

Deployments
Location Time Zone
Denver (UTC-07:00) Mountain Time (US &
m Canada)
Clients
Name

University of Denver, 001
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8.2 Preferences

8.2 Preferences

You can set several options to change the look and feel of the user interface and default

settings.

Preferences

Site Scheduling

Default Page: Home v Minimum Hours per week: 0 =

Time Zone: (UTC-05:00) Eastern Time (US & Canada) v Desired Hours per week: =

Culture: v Maximum Hours per week: 40 .

Time Format: (Organization/Culture) v Max Days: 7 s

Week Start: Sunday o Max Shifts Per Day: 4 B
Max Hours Per Day: 12 .

Calendar

Default View: Day v

Hours Shown: All Day v

My Hours: Start| 8:00AM  © End 800PM O

Display: Schedule @ Time SwapBoard @ Mylleave  Availability
Events

Public Pages

What is this for?

A Unigue ID is another way to identify yourself to TeamWork. This ID is sent to our public page url's and is not secret. Do not create a Unique ID if you prefer to securely access your schedule information.

Unique Id:

Test your public page:

(o L IR ER_BE L '] Clear.

tmworknet//public/empsch?i

http:
Link to iCal formatted data (copy and paste to other applications):
http://tmwork.net//public/empsch?id = I ==E B R B BEL R & format=ical
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8.2.1 Site Settings

8.2.1 Site Settings

In the "Site" section, you can change several settings that affect the portal.

 Default Page - this sets your landing page upon sign-in. Options are dependent on what your
organization has enabled in TeamWork and can include: Home page, Calendar, Schedule,
Swapboard, Time or Bidding.

» Time Zone - Specifies which time zone to use when displaying dates and times. This is useful
if you work in a different time zone than the location(s) you are assigned.

» Culture - Allows you to specify a language preference as well as date, time, and number
formats.

* Time Format - Use Time Format to choose 24 hour time.

* Week Start - Use Week Start if your prefer to change the view of your calendar to a different
start of week than set by your organization.

Site

Default Page: Calendar Y

Time Zone: (UTC-07:00) Mountain Time (US & Canada) v
Culture: v
Time Format: (Organization/Culture) v
Week Start: Sunday v

8.2.2 Calendar Settings

In the Calendar section, choose your default view for the calendar: day, week, month or list view.
Choose whether to see all hours in a day, or just the time frame of your hours. Choose what to
display on the calendar: Schedule, Time, Swapboard, My Leave, Availability and Events.
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Calendar
Default View: Month v
Hours Shown: All Day v
My Hours: Start End
8:00 AM 8:00 PM
Display: Schedule Time SwapBoard
My Leave Availability Events

8.2.3 Scheduling Settings

8.2.3 Scheduling Settings

In the Scheduling section review the parameters that inform your schedule including your

settings for:

* Minimum Hours per week
* Desired hours per week

* Maximum hours per week
» Max Days per week

* Max Shifts per day

* Max Hours per day
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8.2.4 Public Pages

Scheduling

Minimum Hours per week: 10 -
Desired Hours per week: 18 .
Maximum Hours per week: 64 .
Max Days: 6 :
Max Shifts Per Day: 8 .
Max Hours Per Day: 8 :

8.2.4 Public Pages

The Public Pages section (subject to your organizations settings) allows you to create a Unique
Id which enables a public page. The public page is for viewing your schedule without having to
sign in. This also creates a link for an iCal feed to import your schedule to another application
(such as Outlook or Google Calendar).

Public Pages

What is this for?
A Unique ID is another way to identify yourself to TeamWork. This ID is sent to our public page url's and is not secret. Do not create a Unique ID
if you prefer to securely access your schedule information.

Unique Id: 557bd517-287b-458a-9c33-030213e06e72 Clear
Test your public http://tmwork.net//public/empsch?id=557bd517-287b-458a-9¢33-030213e06e72
page:

Link to iCal formatted data (copy and paste to other applications):
http://tmwork.net//public/empsch?id=557bd517-287b-458a-9c33-030213e06e72&format=ical
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8.3 Notifications

8.3 Notifications

The notifications page lets employees configure emails and text alerts from TeamWork. These
settings are done in a profile that has a scope of either Global or a specific Location. In
general, only a global profile is needed. You might consider a location profile only, if you are
deployed to many locations but only want notifications from one of them.

8.3.1 Adding a Profile

To add a notifications profile:

1. Click the Add button at the top the page

2. Select a scope

3. Click Save
Notification X
Global ]
Denver

(In general, we recommend only using Global notifications.)

Save ‘ Close

To edit the notifications, simply make changes to selections and click Save.
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8.3.2 Notification Options

Notifications ) Calendar ®Clock BEBCard [(s]Leave 58 SwapBoard @
Email Report (Global) Text Messaging
Enabled: Yes - Send Reports o @ Opt-in to receive SMS notifications about scheduling, time and
attendance.
Send Every: Sun [J Mon Tue [JWed [ Thu [JFri [JSat Program: ScheduleSource TeamWork | Message and data rates may apply |
Message frequency will vary | Text HELP for help, Text STOP to cancel |
Include: [J Calendar [JSchedule [JSwapBoard Terms of Service, Privacy Policy
Send Next: v
Reminders
Alerts (Global) Text Me:
. . 60 Minutes v Prior to Shifts
Notify me when: Via:
My Schedule in the next 7 days changes Email ?
POSTED shifts are claimed or removed by manager OText ?

[ Shifts are POSTED (Empty shifts not included) (Email only)
Leave requests change status

[J Events change

[ Invoice status change

8.3.2 Notification Options

The various notification options are grouped on the page. Everything is optional, but enabled
notifications will require a valid email or mobile number in the system. Text messages also
require a separate Opt-In to enable.

Email Report

TeamWork can send an overnight email on the days selected. The data in the email can include
Calendar Events, Scheduled Shifts, and Swapboard shifts. The date range of the data is the
date of the email plus the Send Next number of days in the future. Once days and data are
configured, choose Enabled = Yes to start receiving emails.

Email Report (Global)

Enabled: Yes - Send Reports v

Send Every: Sun (OMon ®@Tue [OWed [OThu [JFri [JSat
Include: [J Calendar [J Schedule []SwapBoard

Send Next: 14 Days v
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8.3.2 Notification Options

Alerts

Alerts for certain changes can be delivered via text or email. In the example below, the
employee does not have valid email or mobile values, so the Via options appear as "?".

Some options depend on the organization configuration.

Alerts (Global)

Notify me when: Via:

My Schedule in the next 7 days changes Email ?
POSTED shifts are claimed or removed by manager (] Text ?

[[] Shifts are POSTED (Empty shifts not included) (Email only)
Leave requests change status

] Events change

[ Invoice status change

Reminders

TeamWork can send a text message either 30 minutes or 60 minutes prior to the start of your
shift. Again, this requires both a valid mobile number and the Opt-In checked.

Reminders

Text Me:
60 Minutes v Prior to Shifts

Text Messaging Opt-In

Text messages cannot be sent without checking Opt-In.
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Text Messaging

Opt-in to receive SMS notifications about scheduling, time and
attendance.

Program: ScheduleSource TeamWork | Message and data rates may apply |
Message frequency will vary | Text HELP for help, Text STOP to cancel |
Terms of Service, Privacy Policy
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8.4 Availability

8.4 Availability

Availability describes days and hours when employees can work shifts. Availability can be

entered as a weekly template, a date-based location template, or single-day overrides.

Availability is separate from the Leave Management system where absences go through an

approval process.

Availability is used as a guide during the scheduling process. Changing availability will not affect

currently assigned shifts.

It's possible to limit availability too much such that no shifts are assignable. Do not attempt to

restrict times down to a single shift length as changing work times and shift strategies by

schedulers might cause there to be nothing available to work.

8.4.1 Availability Calendar

The availability calendar show the combined, effective availability of all templates, overrides, and

granted leave. It does not allow editing. Users must edit on the templates or overrides pages.

Avail Calendar B 0B85 % @
O

Today <« » & February, 2024 Day Week m

Sunday Monday Tuesday Wednesday Thursday Friday Saturday

28 29 30 31 01 02 03

l(GI.OBAl) “(GLOBAD || 12:30pm - 8pm ”(GI.OBA[) |* H* H 1pm - |
04 05 06 07 » 08 09 10

I(GI.OBAL) “(GI.OBAI.) || 12:30pm - 8pm H(GI.OBAL) ||* H* H 1pm - |
11 12 13 14 » 15 16 17

I(GI.OBAI.) ”(GI.OBAL) || 12:30pm - 8pm H(GI.OBAI.) ”* H* H 1pm - |
18 19 20 21 22 23 24

|(GI.OBAI.) ”(GLOBAI.) || 12:30pm - 8pm H(GI.OBAI.) ”* H* H 1pm - ’
25 26 27 28 29 01 02

|(cLoBA [ toBan ||12:30pm - 8pm || (GL08A0) H* 1B || 1pm - ]
03 04 05 06 07 08 09

|(6Lo8AD [ cLoean |[12:30pm - 8pm || (6L08AD |- IB | 1pm - ]
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8.4.2 Availability Templates

8.4.2 Availability Templates

An availability template represents a generic, recurring 7-day week. Each template describes the

available days On/Off, the day Priority (1 = lowest, 9 = highest), and optionally limited Times

available to work. There's also optional preferred times that managers can use for scheduling.

There are two types of templates:

1. Global - applies the same rules to all locations

2. Local - applies to a single location

In addition, templates can be Date-Based so that they're only in effect on those dates.

The absence of a template simply defaults to all days/times as available. Setting up availability is

optional and sometimes not needed according to how the organization schedules.

Details Times: (UTC-07:00) Mountain Time (US & Canada)

Day On/Off Priority Available Hours
Sunday Off v

Monday Off v

Tuesday On v 1 v 12:30pm-8pm; o 150

Wednesday off v

Thursday On v 1 v All DA o 2400
Friday On v 1 v ATy « 2400
Saturday On v 1 v 1pm-; o 11.00

Adding a Template
To add a new template:

1. Click the Add button at the top of the page
2. Select a Scope (Global or location)
3. Optionally enter a date-range for a date-based template

4. Click Save
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8.4.2 Availability Templates

Add - Template X
Scope: Name:
Denver Denver (Date Based)
Denver (Date Based) Dates:
Start B - End i

Save Close

Editing a Template

Templates are edited using the template page. Select a template to view/edit from the drop-
down at the top of the page.

Choose values in the drop-downs to toggle days On/Off or set Priority.
To edit the times, click the down-arrow in the Available column to reveal time entry boxes.

You can enter multiple blocks of available times. When editing, the page will always give you a
few extra boxes in case you want to add another block.

Tuesday On v 1 v 12:30pm-8pm; o 150
12:30 PM ©  8:00 PM ®©
From ® | To ®
From ® | To ®

Time blocks can be open-ended by leaving the start or end time blank. For instance, if available
until 3 PM, you might just enter the end time of 3 PM.
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8.4.3 Availability Overrides
From ©  3:00 PM C) |

After making changes, you must click Save to update the template.

Deleting a Template
To delete a template:

1. Select/Open the template using the drop-down

2. Click Delete and confirm

8.4.3 Availability Overrides

Overrides act as date-based exceptions to the availability defined in the template(s). Each
override is global or for a single location, is for a single date, and specifies if the override is On
or Off availability. If an On override, blocks of time may be entered.

To add an override, go to the Overrides page, then

1. Click Add

2. Enter or select a Date

3. Specify the Scope

4. Choose On or Off

5. Optionally enter time blocks (if On)
6. Click Save
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Override

Date:  3/7/2024 &

Scope: Global v
On/Off: Off -

Times: (UTC-07:00) Mountain Time (US & Canada)

Global availability does not adjust for time zones.

‘ Close

Editing Overrides
To edit an override:

1. Click Open in the actions column of the overrides list
2. Make changes
3. Click Save

Deleting Overrides
To delete an override:

1. Click Open in the actions column of the overrides list

2. Click Delete

8.4.4 \olunteer Lists

8.4.4 Volunteer Lists

A volunteer list is a simple sign-up list that helps managers limit scheduling to only those in the

list. Volunteer lists are per location.

To see volunteer lists, select a Location from the drop-down at the top of the page.
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8.4.4 Volunteer Lists

Avail Volunteer ) Calendar (O Clock EBCard [(¥]lLeave &3 SwapBoard
Denver v @
List Volunteer Start End Actions
test Yes ’ Open ’

To add or remove yourself from a list, click the Open button in the Actions column.

Choose Yes or No for the volunteer value, click Save.

Volunteer X
List: test
Volunteer:  Yes -
Dates: M - M

Some lists are date-based and will be limited to volunteering only on those dates.
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8.5 Credentials

8.5 Credentials

Credentials are records of qualifications, training, and formal credentials that may be required to

fulfill certain positions or tasks. For some configurations, employees can enter credentials

directly from the portal. In addition to tracking credentials, an organization might establish goals

for training, etc. to be met over some period.

8.5.1 Viewing Credentials

In the main menu, navigate to My Setup > Credentials > List. This loads the full list of your

credentials (past, present, pending, etc.).

My Credentials B © 8B > s Paul Green @

| Add

Drag a column header and drop it here to group by that column

Name Y Due Y Start Y End Y Completed Y Notes Y Status

Lift 50 Lbs 1/1/201 12/31/2021 1/1/201M [v] OK

Adding Credentials
To add a credential, click the Add button above the list.

In the pop-up:

1. Select a pre-defined credential type

2. (Optional) Enter the effective dates (for expiring credentials)
3. (Optional) Enter a due date (if pending completion)

4. Enter a completed date (Optional)

5. Enter a note

6. Click Save
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8.5.2 Viewing Goals

Add X
Credential: ‘Security Best Practices v ‘
Effective Dates: B - &
Due: =
Completed: 1/25/2024 {3
Note:

Vi

‘ Close ’

8.5.2 Viewing Goals

To view your progress against an organization's goals, click Goals in the main menu (under
Credentials).

This view lists goal programs on the left.

Click a program to load the progress report.

Goals A O B E s Paul Green @

@

Cont. Education Cont. Education / Green, Paul
1/1/2022 - 12/31/2022 Units: 4

Goal Target Approved Percent

Units - 0 0.0%
Credential Units Hours Completed Status Files
National Conference 3 ‘ Add ‘
Security Best Practices 1 ‘ Add ‘
Translation Certification 3 ‘ Add ‘
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9. Bidding

9. Bidding

9.1 Shift Bidding

Shift bidding is the process of selecting a recurring pattern of shifts for a time period. A single

pattern of shifts is called a "Line" or a "Tour". In general, employees are ranked by seniority (or
similar method) and lines are awarded in that order. Each line might have a capacity of one or
more employees. Once assignments are made up to a line's capacity, it is no longer available.

Prior to the assignment process, employees enter their choices (bids) and establish their priority
(first, second, third, etc.). Employees can enter as many bids as necessary to ensure a choice is
awarded. Choices can be added, removed, or re-prioritized prior to the assignment process.

The start page for shift bidding is the List page, found in the menu under Bidding > Shift Bids
> List.

Vv Bidding
Vv Shift Bids
Home
Search

Bid Sheet

History

9.1.1 Selecting a Bid

Using the menu, open the Shifts Bids List page. Then click on the name of the bid, or one of the
page links (Home, Search, or Bid Sheet). Once a bid is selected, the other pages in the menu
will load for that bid.
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9.1.2 Home Page

Shift Bids Welcome to V6! B O B E Paul Green @
Shift Bids o
Name Start { End ¢ Stage

v Status: Select

2024 Full Bid Home | Search | Bid Sheet 12/31/2023 12/28/2024 Select
¥ Status: Complete
2021Q1 Home | Search | Bid Sheet 1/3/2021 4/4/2021 Complete

9.1.2 Home Page

The home page for a bid shows setup information and any messages for the bid. Your overall
rank is listed under "My Status".

Shift Bids B O &8 & 8 Paul Green @
2024 Full Bid / Home Home | Search | Bid Sheet ¢
Bid My Status

Name: 2024 Full Bid Rank: 6

Dates: Dec 31, 2023 (Sun)- Dec 28, 2024 (Sat) Status: No Assignment
Stage: Select Assigned: (0 of 10 employees.)

Privileges: Messages

Bidding Timeline

On December 15th, you can start bidding on lines.

We will process the choices one week later on December 22nd.

Posted By: Hammers, Scott, 1/24/2024

9.1.3 Viewing Lines (Search)

The Search page lists all lines and related information. If the bid is accepting choices, then
buttons are available for adding new choices and editing existing ones.

There are several links to click on for additional information. Each option is summarized below.
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9.1.3 Viewing Lines (Search)

Shift Bids RO N =] Paul Green @
2024 Full Bid / Search Home | Search | Bid Sheet )
--- Filters --- v m View All ~
Name Y Pattern Y Position Y StartTime Y End Time Y Hours Y Capacity Y Available Y Bids Y MyBids Y
@ s [l s | Tech 800AM  500PM 40.00 1 1 @ [ Add
B 1 5|6 11|12 Pool 600AM 500 PM 7000 1 1 (o] | Add]
@ 2(3|4 9|10 Pool 6:00 AM 5:00 PM 70.00 1 1 @ E‘
Count: 3 3 3
Ko<« > 3 v | items per page 1-3 of 3 items

Calendar View of Line

Click the button in the "Name" column or click the "Pattern" days to open a calendar view of the

line's shifts.
r
View » Line : B X
Calendar | List
Today <« » £ January, 2024 Week m
Sunday Monday Tuesday Wednesday Thursday Friday Saturday
31 01 02 03 04 05 06
6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a
Pool Pool Pool Pool
07 08 09 10 1 12 13
6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a
Pool Pool Pool Pool
14 15 16 17 18 19 20
6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a
Pool Pool Pool Pool Pool
21 22 23 24 25 26 27
6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a
Pool Pool Pool Pool
28 29 30 31 01 02 03
6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a
Pool Pool Pool Pool
04 05 06 07 08 09 10
6am - 5pm 6a 6am - 5pm 6a 6am - 5pm 6a
Pool Pool Pool
Other Choices

Click the button (with count) in the "Bids" column to see a list of other employee's choices.
Depending on the settings, the names of other bidders may or may not be listed.
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9.1.3 Viewing Lines (Search)

View Bids X
B:
Capacityzo Assigned:o Higher Bids:
Bids:
Name Rank Choice
Fischer, Dave 4 3rd
Hamm, David 10 1st
‘ Close ‘
—

Add Choices
The "My Bids" column provides buttons to add or edit your choices. To add a new choice:

1. Click Add in the "My Bids" column for the line

2. (Optional) Select the choice number (priority)

3. Click Save
Bid X
Name: A
Positions: Tech
Times: 08:00 - 17:00
Hours: 40.00
Choice: ‘1 v’
- B
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9.1.3 Viewing Lines (Search)

When added, the column updates to text with "Saved" and the choice number. The page will
need to be refreshed to have the edit buttons show. The refresh link is at the top right of the
page/toolbar.

Bids Y MyBids Y

1 Saved (1)
2 Add
2 Add

The refresh link:

Home | Search | Bid Sheet | C)

Edit Choices

Existing choices and their priority are listed in the "My Bids" column. To edit or delete a choice,
click the button for that link.

In this example, the blue button (1) is the employee's first choice.

Bids Y MyBids Y

2 1st
2 Add
2 Add
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9.1.3 Viewing Lines (Search)

To change the choice number (priority):

1. Select a new value from the drop-down (limited to valid values),

2. Click Save.
To delete the choice:

1. Click Delete

( A
Bid X
Name: A
Positions: Tech
Times: 08:00 - 17:00
Hours: 40.00
Choice: ’1 V‘

‘ Delete Close ‘

View All

The View All page opens in a new tab and lists all lines across all dates, and summarizes the
days that are OFF or have shifts. Clicking the links by "Text" will show or hide that text in the
view. (Hiding station names helps the view if you only want to see days off).
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2024 Full Bid

December, 2023
1 2 3 4 = 6 7
Fri Sat Sun Mon Tue Wed Thu

c

January, 2024

8 9 10 11 12 13 14
Fri Sat Sun Mon Tue Wed Thu

1 2 3 4 5 6 7 8 9 10 1 12 13 14
Mon Tue Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri Sat Sun
A Tech Tech Tech Tech Tech OFF OFF Tech Tech Tech Tech Tech OFF OFF
B Pool Pool Pool OFF OFF Pool Pool Pool Pool OFF OFF OFF Pool Pool
¢ OFF OFF OFF Pool Pool Pool Pool OFF OFF Pool Pool Pool OFF OFF
February, 2024
1 2 3 4 5 6 7 8 9 10 11 12 13
Thu Fri  Sat Sun Mon Tue Wed Thu Fri Sat Sun Mon Tue
A Tech Tech OFF OFF Tech Tech Tech Tech Tech OFF OFF Tech Tech
B Pool Pool OFF OFF OFF Pool Pool Pool OFF OFF Pool Pool Pool
¢ OFF OFF Pool Pool Pool OFF OFF OFF Pool Pool Pool Pool OFF

Favorites

Text: Station | Off

15 16 17 18 19 20 21 22 23 24 25 26 27 28 29
Fri Sat Sun Mon Tue Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri
15 16 17 18 19 20 21 22 23 24 25 26 27 28 29
Mon Tue Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri Sat Sun Mon
Tech Tech Tech Tech Tech OFF OFF Tech Tech Tech Tech Tech OFF OFF Tech
Pool OFF OFF Pool Pool Pool Pool OFF OFF OFF Pool Pool Pool OFF OFF
OFF Pool Pool Pool Pool OFF OFF Pool Pool Pool OFF OFF OFF Pool Pool
14 15 16 17 18 19 20 21 22 23 24 25 26 27
Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri Sat Sun Mon Tue
Tech Tech Tech OFF OFF Tech Tech Tech Tech Tech OFF OFF Tech Tech
Pool OFF OFF OFF Pool Pool Pool OFF OFF Pool Pool Pool Pool OFF
OFF Pool Pool Pool OFF OFF OFF Pool Pool Pool Pool OFF OFF Pool

9.1.4 Bid Sheet

30 31

Sat  Sun
OFF
OFF

Pool

31
Wed
Tech
Pool

30
Tue
Tech
Pool

Pool Pool

29
Thu
Tech
OFF
Pool

28
Wed
Tech
OFF
Pool

Favorites provide a way to define a filter/query to select a subset of lines. If you define a filter it
can be used in two ways: 1) filter the Search list for readability, and 2) add a Favorite Choice.

Favorites are optional, and are an advanced option. (More help pending...)

9.1.4 Bid Sheet

The bid shift page lists your bids in priority order. The first three columns provide links to edit the

choice and/or view the line in a calendar.

The summary at the top lists the total lines in choices (individual lines plus favorites) and the

remaining lines available (after some assignments have been made).

The PDF button at the bottom generates a PDF file for download of the page. This is useful to

save a non-editable record of the final bid sheet.
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Shift Bids

2024 Full Bid / Bid Sheet

Lines: [§) Available: €
Lines
Choice Name Pattern Position Start Time End Time
1t N s M |w|T]e]s] Tech 800AM  5:00PM
Favorites
Choice  Name

No records available.

9.1.5 History

B 083 8

Home | Search | Bid Sheet

Paul Green @

@

Hours Available

Capacity

40 1 1

Lines Available

1/24/2024, 11:01:03 AM
@ PDOF |

9.1.5 History

The history page lists edits to employee data and choices. This page is read-only and provides a

log the changes that might affect the results of bidding. The timestamp fields at the top allow

filtering to certain time spans. The "By" and "For" fields allow limitin
the history.

g to certain text (names) in

B 0 ®BF F Paul Green @

2024 Full Bid / History ¢
Timestamp ActionBy For
1/24/202412:00AM [ © - Maximum 5O v Name Name YNVl Clear
Timestamp Action Source Summary By For
1/24/2024 10:36 AM ChoiceAdd A Paul Green Green, Paul
1/24/2024 9:12 AM RankAssign Hammers, Scott
<« B > M 25 ¥ | items per page 1-2 of 2 items
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9.2 Leave Bidding

9.2 Leave Bidding

Leave bidding is the process of selecting dates for vacation or other leave in advance, with an
award process (or processes) governed by organizational or union rules. Employees are ranked
by seniority (or similar method) and leave is awarded in that order. An organization might award
leave in several "rounds”, each with different rules or constraints. Availability of leave dates can
be constrained by limits on the day, the leave type, or the employee's available balance.

Employees may choose to enter "alternate" choices such that two choices are either/or in the
assignment process. For example, having a first choice of the 2nd week in July, with the
alternate choice being the 3rd week in July. The system could assign the first OR second, but
not both.

The start page for leave bidding is the List page, found in the menu under Bidding > Leave
Bids > List.

v Bidding

> Shift Bids

V' Leave Bidding
Home
Search
Bid Sheet
Balances

History

9.2.1 Selecting a Bid

Using the menu, open the Leave Bids List page. Then click on the name of the bid, or one of the
page links (Home, Search, or Bid Sheet). Once a bid is selected, the other pages in the menu
will load for that bid.
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9.2.2 Home Page

Leave Bidding B0 ®B 5 Paul Green @

Leave Bidding o

Location Name Start End Stage

¥ Status: Select

Denver 2024 Date List Home | Search | Bid Sheet 12/31/2023 12/28/2024 Select
¥ Status: Assign
Denver 2023 Date List Home | Search | Bid Sheet 1/1/2023 12/30/2023 Assign
¥ Status: Complete
Denver Dept 1 - 2021 Vacation Bid Home | Search | Bid Sheet 1/1/2021 12/31/2021 Complete
Denver TEST FEB Home | Search | Bid Sheet 2/1/2017 2/28/2017 Complete

9.2.2 Home Page

The home page for a bid shows setup information and any messages for the bid. Your overall
rank is listed under "My Status". Please note the "round rules" located at bottom-left. (In this
case there's one round: R1.) This section will describe what the constraints for awards are for

each round.

Leave Bidding B 086 Paul Green @
2024 Date List / Home Home | Search | Bid Sheet ¢
Bid My Status

Name: 2024 Date List Rank: 6
Dates: Dec 31, 2023 (Sun)- Dec 28, 2024 (Sat) Balances
Notes: test PTO 120.00 / 160.00 hours remaining
Stage: Select Assigned: (0 of 10 employees.)
Current Round: R1 Messages
Privileges:
Bidding Dates
1) R1

Please enter PTO choices the first week of December.
« Date range unit is DAY. Each range must be between (1) & (28) days.

We will assign Round 1 the Friday of the 2nd week of December. Round 2 will be
assigned the next Friday.

Posted By: Hammers, Scott, 1/24/2024

9.2.3 Viewing Dates (Search)

The Search page lists all lines and related information. If the bid is accepting choices, then
buttons are available for adding new choices and editing existing ones.

Depending on the settings, you may be able to view by Week or Day, or by List. The "List" view
is based on a pre-defined list of date ranges available for leave. For Week and Day, the
organization may allow week-at-a-time or even employee-selected date ranges.
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9.2.3 Viewing Dates (Search)

There are several links to click on for additional information. Each option is summarized below.

Leave Bidding

B O B8R Paul Green @

2024 Date List / Search Home | Search | Bid Sheet )
PTO  120.00 / 160.00 hours remaining
Da List
Start Y End Y Nahe Capacity Y Granted Y Available Y Bids Y My Bids

12/31/2023 (Sun)|  1/7/2024 (Sun) 3 0 3 \E\
1/7/2024 (Sun)| 1/14/2024 (Sun) 3 2 1 [1] (Add ]
1/14/2024 (Sun)  1/21/2024 (Sun) 3 3 0 | Add |
1/21/2024 (Sun)  1/28/2024 (Sun) 3 0 3 [1] 1st

1/28/2024 (Sun)  2/4/2024 (Sun) 3 3 0 | Add |
2/4/2024 (Sun)|  2/11/2024 (Sun) 3 0 3 [ 1] | Add |
2/11/2024 (Sun)  2/18/2024 (Sun) 3 0 3 (2] 2nd

2/18/2024 (Sun)  2/25/2024 (Sun) 3 0 3 | Add |

Other Choices

Click the button (with count) in the "Bids" column to see a list of other employee's choices.

Depending on the settings, the names of other bidders may or may not be listed. If you have bid

on those dates, your name will appear in the list.

Rank Name
6 Green,
9 -
9 -

Date: Sunday, February 11, 2024

Capacity: [fJ) Granted: ) Available: [E)

Paul

X
Choice
2nd
1st
2nd
‘ Close ‘
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9.2.3 Viewing Dates (Search)

Add Choice
The last column provides buttons to add choices. To add a new choice:

1. Click Add button in last column

2. Select dates or a date range

3. Select a Leave Type

4. (Optional) Select the choice number (priority)
5. (Optional) Enter an alternate choice number

« If using alternates, the primary choice number should match an existing choice

6. Click Save
Add » Choice X
Date Range: 1/28/2024 (Sun) - 2/4/2024 (Sun) M
Leave Type: PTO v
Choice.Alternate: 3 . .
Add
Close
Edit Choice

The "My Bids" column provides buttons to edit or delete your choices. To edit a choice:

1. Click the 1st, 2nd, etc. button in the "My Bids"
2. (Optional) Select the choice number (priority)
3. (Optional) Enter an alternate choice number
« If using alternates, the primary choice number should match an existing choice

4. Click Save
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To delete the choice, click the Delete button.

9.2.4 Bid Sheet

Edit » Choice

Dates | Check Rules @ | Check Availability @
Select dates and click Save to include in the choice.
All date ranges combine for a single choice and will be awarded all or nothing.

Start End Type

2/11/2024 2/18/2024 PTO
Choice# . Alternate#

a a
2 v m Save

Delete

‘ Close ‘

9.2.4 Bid Sheet

The bid shift page lists your bids in priority order. The first column provides links to edit the

choice.

The summary at the top lists the leave type(s) and hours remaining of the total hours available.

The PDF button at the bottom generates a PDF file for download of the page. This is useful to

save a non-editable record of the final bid sheet.

Leave Bidding

2024 Date List / Bid Sheet

| Add |
Choice Alternate  Dates
1st Jan-21 (Sun) - Jan-28 (Sun) PTO
2nd Feb-11 (Sun) - Feb-18 (Sun) PTO

B O 8 H 5 Paul Green @

Home | Search | Bid Sheet )

PTO  120.00 / 160.00 hours remaining

Weeks Days Hours
1.6 8.0 64.0
16 8.0 64.0

1/25/2024, 4:43:51 PM
@ PDF

- 86/105 -

Copyright © 2023-2024 ScheduleSource, Inc.



9.2.5 Balances

9.2.5 Balances

The balance page provides details about leave types and the total (Quota) available. The
Granted, Taken (granted dates in past), and Remaining values are listed for both Hours and
Days (if enabled).

Leave Bidding B O B F Paul Green @
2024 Date List / Balances | 2023 B o< > o
Name Check Start End Quota (Hours) Granted Taken Remaining Quota (Days) Granted Taken Remaining
PTO No 1/1/2023 12/30/2023 160 40 40 120 0 0

9.2.6 History

The history page lists edits to employee data and choices. This page is read-only and provides a
log the changes that might affect the results of bidding. The timestamp fields at the top allow
filtering to certain time spans. The "By" and "For" fields allow limiting to certain text (names) in

the history.
B O8B8E $ Paul Green @
2024 Date List / History (@]
Timestamp Action By For
1/25/2024 12:00 AM B ©® - Maximum B o v Name Name Clear
Timestamp Action Source Summary By For
1/25/2024 4:33 PM DateRangeAdd 2 Paul Green Green, Paul

1/25/2024 4:33 PM  ChoiceAdd 2
1/25/2024 4:33 PM DateRangeAdd 1 Paul Green Green, Paul
1/25/2024 4:33 PM  ChoiceAdd 1

Paul Green Green, Paul

Paul Green Green, Paul

LI L | 25 ¥ | items per page 1 -4 of 4 items
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9.3 Custom Bidding

9.3 Custom Bidding

Custom bidding is the process of selecting items with an award process (or processes) that
utilizes custom rules and logic. An organization might award items in several "rounds", each with
different rules or constraints. The customizable logic and data attributes on employees and
items provides maximum flexibility to the organization.

Employees can view items based upon a filter. The filter is set by the organization and helps to
limit the scope of items to only those the employee is qualified to bid on.

The start page for custom bidding is the List page, found in the menu under Bidding > Custom
Bids > List.

“  Bidding
> Shift Bids
> Leave Bidding
v Custom Bidding
= List
Home

ltems

Bid Sheet

9.3.1 Selecting a Bid

Using the menu, open the Custom Bids List page. Then click on the name of the bid, or one of
the page links (Home, Items, or Bid Sheet). Once a bid is selected, the other pages in the
menu will load for that bid.

- 88/105 - Copyright © 2023-2024 ScheduleSource, Inc.



9.3.2 Home Page

Custom Bidding

Custom Bidding

Name Stage
¥ Status: Assign

2024 Q2 Training Home | Items | Bid Sheet Assign
2024 Q3 Training Home | Items | Bid Sheet Assign

9.3.2 Home Page

The home page for a bid shows setup information and any messages for the bid. Your attributes
for the bid are listed under "My Attributes". This information is used by the custom logic to filter,
sort, and rank you among all other bidders.

Custom Bidding

2024 Q3 Training / Home Home | ltems | Bid Sheet )
Information Bid
Organization: _SSI Enterprises_ Name: 2024 Q3 Training
Employee: David Hamm Notes:
My Attributes SEgE assion
name key value Privileges: Bid Rankings
Level 3
Region West Messages

9.3.3 Viewing Items

The Items page lists all items and related information. If the bid is accepting choices, then
buttons are available for adding new choices and editing existing ones.

Depending on the settings, you may be able to choose different Layouts of the data. From the
items page you can click an item "Title" to view more information, click in the "Bids" column to
see other bidder's choices, or click "Add" to enter your own choice.

There are several links to click on for additional information. Each option is summarized below.
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9.3.3 Viewing Items

Custom Bidding

2024 Q3 Training / Items Home | Items | Bid Sheet )
Layout: List v
Drag a column header and drop it here to group by that column
Title Y Quantity Y Level Y Region Y Week Y Bids Y Bid Y
Course 101, NYC (7/6) 1 1.00 East w28 4 | Add |
Course 101, Dallas (7/20) 1 1.00 South W30 2 |Add |
Course 101, Austin (8/3) 1 1.00 South w32 2 | Add |
Course 101, San Francisco
@ 1 1.00 West W34 2 |Add |
Course 101, London (8/31) 1 1.00 Europe W36 4 |Add |
Course 101, Atlanta (9/14) 1 1.00 East W38 2 n
Course 101, Paris (9/28) 1 1.00 Europe W40 6 n
Add Bid

The last column provides buttons to add your bids. To add a new bid:

1. Click Add button in last column

2. Verify the item information

3. Select a choice number (either for a current choice to insert, or at the end of list)

4. Click Save

Add » Bid

Course 101, Dallas (7/20)

Externalld Quantity
C101W30 1
attribute key value
City Dallas

Level

Region South

Week W30

My Bid
Rank
O#
O#2
O#3
O #4
O#5
O #6
O #7
O #8
O#9
O#10
O #11
O#12

Iltem

Course 300, Austin (9/7)
Course 400, Denver (8/24)
Course 500, Austin (7/20)
Course 400, San Francisco (8/31)
Course 300, Denver (8/3)
Course 210, Denver (7/20)
Course 200, Denver (7/6)
Course 101, Paris (9/28)
Course 500, Denver (9/21)
Course 101, Atlanta (9/14)

Course 210, NYC (9/14)

Save ‘ Close
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Edit Bid

9.3.3 Viewing Items

The "My Bids" column provides buttons to edit or delete your bids. To edit a bid:

1. Click the 1st, 2nd, etc. button in the "My Bids"

2. (Optional) Select a new choice number (priority)

3. Click Save

To delete the bid, click the Delete button.

Edit » Bid X
Course 101, Paris (9/28) My Bid
Rank Item
Externalld Quantity
O #1 Course 300, Austin (9/7)
C101W40 1 o#2 Course 400, Denver (8/24)
O #3 Course 500, Austin (7/20)
attribute key value O #4 Course 400, San Francisco (8/31)
City Paris O #5 Course 300, Denver (8/3)
Level O #6 Course 210, Denver (7/20)
O #7 Course 200, Denver (7/6)
Region Europe
#8 Course 101, Paris (9/28)
Week W40 O#9 Course 500, Denver (9/21)
O #10 Course 101, Atlanta (9/14)
O #11 Course 210, NYC (9/14)
O End
Delete Close
Other Bids

Click the button (with count) in the "Bids" column to see a list of other employee's bids.

Depending on the settings, the names of other bidders may or may not be listed. If you have bid

on those items, your name will appear in the list.
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Bids

Externalld

c101wz28

Count o

Course 101, NYC (7/6)

Quantity

1

‘ Close ‘

9.3.4 Bid Sheet

9.3.4 Bid Sheet

The bid shift page lists your bids in priority order. The first column provides a links to edit the

choice. The "Title" can be click to see the item's detailed information.

The PDF button at the bottom generates a PDF file for download of the page. This is useful to

save a non-editable record of the final bid sheet.

Custom Bidding

2024 Q3 Training / Bid Sheet

Layout: List

Bid

(=]

Title
Course 300, Austin (9/7)
Course 400, Denver (8/24)

Course 500, Austin (7/20)

Course 400, San Francisco
(8/31)

Course 300, Denver (8/3)
Course 210, Denver (7/20)
Course 200, Denver (7/6)
Course 101, Paris (9/28)
Course 500, Denver (9/21)
Course 101, Atlanta (9/14)

Course 210, NYC (9/14)

Quantity
1
2

2

1

1

Level

3.00

3.00

3.00

3.00

3.00

2.00

2.00

1.00

3.00

1.00

2.00
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Region
South
West
South
West
West
West
West
Europe
West
East

East

Week

W37

W35

W30

W36

W32

W30

w28

w40

W39

w38

w38

Home | Items | Bid Sheet )

Bids

2
2

3/6/2024, 5:36:24 PM
| @ poF |
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10. Events

10. Events

10.1 Events

TeamWork provides an optional event (task) management system. Events are created
independently of shifts. If an event is attached to a shift, it is consider the responsibility of the
employee working the shift. In this way events can be requested and planned independently of
scheduling, and the linking of events to shifts completes their assignment.

Employees can manage their events by entering status (Cancelled, Complete, etc.) and
optionally tracking time spent on the event. There are two pages for viewing/managing events:
My Events and By Shift.

10.1.1 My Events

This page lists events in chronological order for a day, week, or month at a time (see Date
Navigation). You can group the events by dragging a column header up to the group bar.

You can open the event and edit status, etc. by clicking the Open button. The fields available to
edit are defined by the organization.

Events / My List B O© 8 & £  David Hamm@®
Week v 1/19/2024 B[<|[> o
t Client @
Scheduled Name Position Client Start Hours Note Status Actions

¥ Client: University of Denver, 001

Tue, 1/16/2024 Task A Tech University of Denver, 001 9:00 AM Open
Wed, 1/17/2024 Task A Tech University of Denver, 001 8:45 AM Open
Wed, 1/17/2024 Task B |Tech University of Denver, 001 1:00 PM Open
Tue, 1/16/2024 Task B Tech University of Denver, 001 1:00 PM Open

10.1.2 By Shift

This page groups the events by assigned shifts. Click the name of the event to open the editor.
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10.1.2 By Shift

Events / By Shift A O B David Hamm @

Week v 171972024 & \Z\ \Z\ o

Tuesday, 1/16/2024 9:00 AM | University of Denver, 001 | Tech

Task A

Tuesday, 1/16/2024 1:00 PM | University of Denver, 001 | Tech

Task B

- 94/105 - Copyright © 2023-2024 ScheduleSource, Inc.



10.2 Other Events

10.2 Other Events

This page shows the events for the selected date that are assigned to yourself and others. You
can change dates with either the date-picker or the previous/next arrows. If you are not
scheduled on the date, no events are listed.

This view allows employees to understand the distribution of events/tasks. Under some
configurations, a lead employee can re-assign events to better optimize the workload.

Events / Other

1/17/2024

t Client

Date

& <>

Name

Position

¥ Client: University of Denver, 001

1/17/2024
1/17/2024
1/17/2024
1/17/2024

Task A
Task D
Task B
Task C

Tech
Pharmacist
Tech
Tech

Client

University of Denver, 001
University of Denver, 001
University of Denver, 001
University of Denver, 001

Start

8:45 AM
9:00 AM
1:00 PM
3:30 PM

B O &3 David Hamm @

Employee

Hamm, David

Hamm, David

@

Hours Status Actions

- 95/105 -

Copyright © 2023-2024 ScheduleSource, Inc.



10.3 Unassigned Events

10.3 Unassigned Events

This page shows the unassigned events for today. The events may our may not have an
associated shift. In either case, the event has no assignment.

This view allows employees to understand availability of events/tasks in real time. Under some
configurations, a lead employee can re-assign events to better optimize the workload.

Events / Unassigned

B 0O BE David Hamm @
Today's Unassigned:

@
Drag a column header and drop it here to group by that column
Client Y Position Y Name Y
University of Denver, 001 Tech Task A
University of Denver, 001 Tech Task B
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11. Invoices

11. Invoices

11.1 Using Invoices

The invoices page allows entering organization-defined invoice forms. Each form have fields and

values to enter or select. Some fields might be required while others are optional. You can add,
edit, and approve invoices from the "List" page.

11.1.1 List Invoices

The invoice list shows every invoice entered for the selected date range. Use the Date Navigator
at the top of the page to load data for different time periods.

Each invoice is for a date or date range. Invoices are optionally linked to a Client record (per
invoice setup). The invoice type, date(s), client, and approval status are shown in the list.

Invoices / List

Month v 1/12/2024 3 | < | > | | Add|
Invoices Please select an invoice from list...
Daily Service Record
1/9/2024
Daily Service Record
1/12/2024

Click on an invoice in the list to open the invoice editor.
Approvals

The status of each invoice is shown in the list. A light-blue check indicates "Employee
Approved". A dark-blue check indicates "Manager Approved". In the example below, the first
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11.1.2 Add Invoice

invoices has both Manager and Employee approval. The second invoice has an Employee
approval. The third invoice has no approvals.

Invoices

Daily Service Record

1/3/2024 ]
Daily Service Record

1/9/2024 f
Daily Service Record

1/12/2024

Declined

Invoices can also be "Manager Declined" if there are reasons for rejecting the invoice. The
Declined status is indicated with a red-x. A "Declined" invoice must be corrected (changed and
re-saved) prior to another Employee approval. In the example below, the second invoice has
been "Manager Declined".

Invoices

Daily Service Record

1/3/2024 (v ] v
Daily Service Record

1/9/2024 00
Daily Service Record

1/12/2024

11.1.2 Add Invoice

To add an invoice, click the add button at the top of the page. This will open a pop-up with the
new invoice options. On the pop-up:

1. Select an Invoice Type

2. (Optional) Select a Client for the invoice

3. Enter a Date or date range

4. Click Save
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11.1.3 Edit Invoice

Invoice X

Type:

Daily Service Record v
Date

1/12/2024

Save ‘ Close ‘

11.1.3 Edit Invoice

Open the invoice editor by clicking an invoice in the list. The editor has three sections. The first
section (Activity) lists shifts and events on the invoice's date. The second section (Invoice)
contains the input fields for all invoice values. The third section (Files) allows you to upload

attachments to the invoice.

To edit the invoice values, fill out the fields in the Invoice section and click "Save". If required
fields are not entered, a warning will be displayed and no values are saved. After a successful

save, the Timestamp value will be populated.
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Invoice v
* Hours Interpreting :

* With Lunch :

Travel Expense :
Total Compensation =

Comments:

Timestamp:

5.50

O No
® Yes

15.75
| completed on time.

1/12/2024 11:57:22 AM

Save

11.1.4 Files

You can edit and re-save the invoice as needed if there are no approvals.

11.1.4 Files

Each invoice can have one or more files (receipts, photos, etc.) attached. The list of attachments

is in the Files section.

Files v ‘E‘

I _gopass_receipt_3211296.pdf (My travel reciept)
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11.1.5 Approve Invoice

Attach File
To attach a file,

1. Click the Add button in the files section
2. Click Browse to find a file to upload

3. (Optional) Enter a Description

4. Click Save

File X

File (pdf, docx, doc, gif, jpg, jpeg, png):
Browse... GoPass_Receipt_3211296.pdf
Description:

My travel reciept

Save ‘ Close ‘

11.1.5 Approve Invoice

The approval status of an invoice is shown at the right side of the page. There are two sections,
one for Employee approval and one for Manager approval.

Approvals

Hamm, David‘ Approve ’

_SSI Enterprises_
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11.1.5 Approve Invoice

To submit an approval,

1. Click the Approve button in the approvals section with your name
* (If undoing, to make corrections, click Undo)

2. This will open the invoice Status pop-up

3. (Optional) Enter a Note

4. Click Save

Status X

Invoice:  Daily Service Record
Date: 1/12/2024

Status: Employee:
Organization:

Change: © Approve Undo Add Note Only

Note:

4

Save Close

Approval History

Below the approvals section, there is an approval history list. This list show each status change
and/or note entered. The list is sorted from most recent to oldest. In the example below, the
invoice was Approved, Declined, Unapproved (remains in declined status while editing), then
Approved. Since the invoice went through a Declined/Undo/Corrected process, the second
approval is also marked with "Corrected".
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History

Corrected | Approved

Hamm, David

1/12/2024 1:09 PM

Hamm, David
will fix

1/12/2024 1:09 PM

Hammers, Scott
1/12/2024 12:29 PM

Hamm, David
1/12/2024 11:57 AM
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11.2 Invoice Reports

11.2 Invoice Reports

Organization may define reports summarizing invoice data. These reports can be shared with

the employee portal. If any reports have been created and shared, they will appear on the
Invoice Reports page.

11.2.1 Viewing Reports

To view report data,

1. Select a report definition in the first dropdown
2. Select a date to query on (default: Invoice date)
3. Select date range (using the Date Navigator)

4. Move to past date ranges using the navigation arrows

Invoices / Reports = ON::: N k== David Hamm @
Totals_Approved v InvoiceDate | 1 5 Month v 1/12/2024 3| < | > | O | Export~ |

v

Invoice: Daily Service Record
(Invoice Date) Dates: 1/1/2024 - 1/31/2024

Date EmpApproved OrgApproved Total_Compensation
1/12/2024 12:00:00 AM 0

1/3/2024 12:00:00 AM 1/12/2024 12:08:47 PM 1/12/2024 12:10:49 PM 264.75

1/9/2024 12:00:00 AM 1/12/2024 1:09:26 PM 466.25

11.2.2 Exporting Data

To export the current report data,

1. Click the Export button

2. Select a file type (CSV can be opened in Excel)
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11.2.2 Exporting Data

|
“Dcsv
D) json

-105/105 - Copyright © 2023-2024 ScheduleSource, Inc.



	TeamWork Employee Guide
	1. TeamWork Employee Guide
	1.1 About TeamWork
	1.2 Common Uses
	1.3 Getting Started
	1.3.1 Top Pages
	1.3.2 Sections


	2. Navigation
	2.1 Main Menu
	2.2 Quick Links
	2.3 User Menu
	2.4 Date Ranges
	2.4.1 Example 1
	2.4.2 Example 2


	3. Home
	4. Calendar
	4.1 Calendar Settings
	4.2 Calendar Pop-Up

	5. Schedule
	5.1 My Leave
	5.1.1 Requesting Leave
	5.1.2 Editing Requests
	5.1.3 Leave Statuses

	5.2 My Shifts
	5.2.1 Swapping Shifts
	5.2.2 Splitting Shifts
	5.2.3 Approving Shifts
	5.2.4 Open a Shift

	5.3 Totals
	5.3.1 Filter Example

	5.4 Swapboard
	5.4.1 Viewing Counts
	Calendar View
	Single Row View

	5.4.2 My Shifts
	5.4.3 Available Shifts
	5.4.4 Claiming a Shift
	5.4.5 Split/Claim a Shift


	6. Time
	6.1 Time Clock
	6.1.1 Opening the Clock
	6.1.2 Clocking On
	6.1.3 Clocking Off
	6.1.4 Transferring
	6.1.5 Viewing Today's Clockings
	6.1.6 Viewing Geo-Location

	6.2 Time Card
	6.2.1 Opening the Card
	6.2.2 Navigating Weeks
	6.2.3 Adding Time
	Add From Schedule
	Add By Day

	6.2.4 Editing Time

	6.3 Timesheet
	6.3.1 Approving Time
	6.3.2 Unapproving Time
	6.3.3 Adding Time
	6.3.4 Editing Time

	6.4 Attendance
	6.4.1 Issues


	7. Organization
	7.1 Organization Shifts
	7.2 Organization Leave
	7.3 Organization Coworkers
	7.4 Organization Messages
	7.4.1 Adding Messages
	7.4.2 Sharing
	7.4.3 Broadcasting

	7.5 Organization Events
	7.5.1 Adding Events
	7.5.2 Sharing
	7.5.3 Broadcasting

	7.6 Organization Feedback
	7.6.1 Viewing Responses
	7.6.2 Adding a Response


	8. My Setup
	8.1 Profile
	8.1.1 Updating Password
	8.1.2 Updating Contact Information
	8.1.3 Viewing and Editing Attributes
	8.1.4 Deployments

	8.2 Preferences
	8.2.1 Site Settings
	8.2.2 Calendar Settings
	8.2.3 Scheduling Settings
	8.2.4 Public Pages

	8.3 Notifications
	8.3.1 Adding a Profile
	8.3.2 Notification Options
	Email Report
	Alerts
	Reminders
	Text Messaging Opt-In


	8.4 Availability
	8.4.1 Availability Calendar
	8.4.2 Availability Templates
	Adding a Template
	Editing a Template
	Deleting a Template

	8.4.3 Availability Overrides
	Editing Overrides
	Deleting Overrides

	8.4.4 Volunteer Lists

	8.5 Credentials
	8.5.1 Viewing Credentials
	Adding Credentials

	8.5.2 Viewing Goals


	9. Bidding
	9.1 Shift Bidding
	9.1.1 Selecting a Bid
	9.1.2 Home Page
	9.1.3 Viewing Lines (Search)
	Calendar View of Line
	Other Choices
	Add Choices
	Edit Choices
	View All
	Favorites

	9.1.4 Bid Sheet
	9.1.5 History

	9.2 Leave Bidding
	9.2.1 Selecting a Bid
	9.2.2 Home Page
	9.2.3 Viewing Dates (Search)
	Other Choices
	Add Choice
	Edit Choice

	9.2.4 Bid Sheet
	9.2.5 Balances
	9.2.6 History

	9.3 Custom Bidding
	9.3.1 Selecting a Bid
	9.3.2 Home Page
	9.3.3 Viewing Items
	Add Bid
	Edit Bid
	Other Bids

	9.3.4 Bid Sheet


	10. Events
	10.1 Events
	10.1.1 My Events
	10.1.2 By Shift

	10.2 Other Events
	10.3 Unassigned Events

	11. Invoices
	11.1 Using Invoices
	11.1.1 List Invoices
	Approvals
	Declined

	11.1.2 Add Invoice
	11.1.3 Edit Invoice
	11.1.4 Files
	Attach File

	11.1.5 Approve Invoice
	Approval History


	11.2 Invoice Reports
	11.2.1 Viewing Reports
	11.2.2 Exporting Data



